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Introduction

Imagine taking your PAF 5 database with you to the
library or to a family gathering...in your pocket.
That’s what you can do with the free, downloadable
PAF for Palm program. If you have any of the
various Palm Operating System (Palm OS) handheld
computers, you can easily export all or part of your
PAF 5 database.

For a review of PAF for Palm, visit this Website:
www.svpafug.org/handhelds.html. For step-by-step
help in using PAF for Palm, keep reading!
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..................... Downloading and Installing
PAF for Palm
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Where Do | download
PAF for Palm?

THE CHURCH OF

JESUS CHRIST
OF LATTER=DAY SATNTS FAMI SEA RC Hu.‘

Browse Calalog | Shopping Carl | Shopper Registration | Address Book | Order Slalus Logon | Search | Help

PAF 5.1.12 Download Instructions and Options

DPAF 51 is now available in more than one language. You can dewnload the program
in one language and add additional languages as needed, or download one file with all
languages and ephions.

Tou can type names and other information in any langnage in PAF 5.1. However, to
see the program screens and reports in one of the languages, vou will need that

language.
- PAF 5.1 in One Language -
To download PAF 5.1 Each file ncludes a user's guide.
1. Click the download button | English Dignlees) | (Size: 97 ME)
for the programm in the .
language you want German | Dawnload | (Size: 10.1 ME)

2. Select and wnte down the | Japanese | Download | (Size: 10.2 ME)

locaty il tt . .
o g Chinese | Download | (Size: 9.8 ME)
3. After the file 15 downloaded, | Korean Download | (Size: 10.3 ME)

g0 to that location and . -
doubla-click the fle you Swedish  Download | (Size: 10.0 ME)

downloaded.

It’s not here!

- Dther Options -
Diownload Lessons (English onty), _ Download | (Size: 8.5 WB)

The lessons are avalable to download or to wiew otline. To use the lessons select
Lessons from the PAF 5 1 Help menu. To see what the lessons look like, click here

Download International Font | Download | (S1ze: 11 MB)
Thus font or another Umcode font 15 needed to display characters from languages such

as Japanese, Chinese, and Korean. Durmg mstallation this font will be copied to the
Windows Font Folder.

- Allin Ome -

All Languages and Options, _ Download | (Size: 38.9 MB)
This includes program files for English, German, JTapanese, Chinese, Korean, and

Swedish, the user's guides, lessons (English only); and mterational font. Tse only if’
you have a high-speed Internet connection, such as DEL.

Also available
PAF data wiewer for Palm handhelds, | Download | ¢ KB)

The Personal Ancestral File 5.0 User's Guide is it the Adebe PDF
format and requires Adobe Acrobat Reader 3.0 or later to view. If
vou need the reader, click here to dewnload it free

FY Get Acrobat|
uiobe  Reader

If'the download is mterrupted (that is, lost phone connection), you will need to return to
this page to begin the download again. You may want to boolunark this page with vour
web browser in case you decide to download other files later

It’s
here

The first question people have about PAF for Palm is where to find it.

Occasionally, visitors to the PAF 5 download page at www.familysearch.orq

can’t find the PAF for Palm download. The problem is that they’re not scrolling
down far enough. It’s near the bottom of the page.

Once you click on the file’s Download button and download it to your computer,
install it by double-clicking on the icon for paf.prc in your PC’s downloads area
(typically My Download Files or an equivalent).
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A Tmstall Tosl

User: | ]

File[z] listed belaw will be installed on your handheld the nest
timme pou perfarm a HotSync operation:

¢ | File Name | File Size | Add.
paf.prc B4k, -
E Remove...
i . Select
F — Tips:

Find ather applizations to inztall on your handheld at
hittp: & Aanangs. handzpring. conm
The ‘Add' button lookz first in the SA0D0-0M folder
inzide your C:APROGRAM FILESYPALM folder. This
folder iz a convenient place to gtore downloaded
handheld files.

s Wl T T I Wl K

PAF for Palm automatically installs itself
in the Install Tool of your Palm OS
desktop software. The next time you do & :'_‘J'tfﬁé tfigre yuu"plnjerf-_:m: 3 Hdntﬁync Dﬂeragﬁnfd the
a HotSync, it will install itself e fets) il e instaled on yeur hancheta
automatically on your handheld. You ] Cancel |

will get the message at right:

Tusiall Teel
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%) 3 1  Click

Address Zalc City Tirne
o G
m avzeebee:
ast HotSync operation
359502, 1:32 amn

[ate Book [ate Book+

@ ¢

aratfiti HotSwne  Kewboard

Mﬂud Mﬁti - gb tf_o
e A

Click

Lacal Swnc Podern Swnc

Now, connect your handheld to your PC
and click on the HotSync icon (above). On
the HotSync screen (at right), click on the
Local Sync icon (if you are connected by a
cable or HotSync cradle). Loy

Enter phone #

------------------------------ -

Copyright © 2002 Silicon Valley PAF Users Group. All rights reserved. May be copied for incidental instructional or personal use
only. Commercial distribution or display is strictly prohibited.



@ G

Garaffiti HotSwne  Keyboard

@ O ©

Pail Merno Fad v Boots

= © @

FHF Frefs: SEcurity

o 0 =
MASTER:
. F b %

TaDaLizt  Welcorme  H-Mazter -

Voila!

Once the program is installed, the
PAF for Palm icon will show up on the
menu list of your handheld.
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..................... Creating and Downloading
a PAF for Palm Database
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Even though your program is installed,
there is nothing yet for you to view in
your PAF for Palm program. You need to
create a database to download.

Inside PAF 5, select Export from the File
pull-down menu.

Note: PAF for Palm alphabetizes all-
uppercase names separately from upper-
and-lower-case names.

If your PAF 5 database has a mixture of
all-uppercase surnames (e.g., JONES)
and upper-and-lower-case surnames (e.g.,
Jones), make the surname capitalization
consistent before you export.

If these capitalization styles are mixed,
go to the Tools pull-down menu, select
Preferences, and click on the Names tab.
Make the names consistent by clicking (or
unclicking) Capitalize surnames on
screens and reports.

We don’t know if this is a bug or a
feature, but in any case, it’s a reality.

|

L@H File Edit Add WView Bearch Tools Window Helg

HNew...

CpEN ... Ctrl+o
Close Ctrl+F 4
cave As...

Select

Import...

Export for TempleReady for Windowrs...

Properties
Backup...
Restore...
Check/Repair...
Delete...

Print Reports... Ctrl+F

1 C:A\My Docurments\histories\brigharns.paf
2 CHAWINDOWS\DESKTOP\ KYM.PAF

3 CioMy Docurments\PAF DATA\Rands5.pat
4 ChMy Documents\PAF DATA \fay.paf

Exit
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—ExportTo

r‘PAFgg

Select

" PAFY

i~ PAF3
 paf 214231

[ Ancegiral File or Pedigree
Fesglirce File

pleReady for OS5

—lInclude

v Motes
[T sources

[T Multimedia links

[T Contact inform ation

W cConfidential data

¥ Full Inform ation an liwing

¥ Mames on living

— Choose the options you want

pleReady for Windows ™ submitter
[
g PAF for Palm ©5® handhelds M LD3 data
" Other GEDCOM 55
Char Set: |UTF-5 -
| 4 . Select All
v __or Partial
—aelected Individuals i
oall /
o F'ar‘t|aL Individuals: 0 Select |
Export... Cancel | Help

I Note: PAF for Palm :
| does not download Sources
| from PAF 5, only Notes. |

Choose the PAF for Palm OS
handhelds option. Decide whether
you want to download Notes,
Confidential data, Full information
on living, and LDS data. Also,
decide if you want to download your
entire database or just part of it

(All or Partial).

For most uses, you probably will
find it easier to work with part of
your database on a handheld,
because handheld navigation is not
as easy as navigation in PAF 5. A
large database of thousands of
names loads and runs slowly.

You can download multiple
databases to your handheld; the
size of the handheld’s memory
capacity is the primary limitation on
the size and number of databases.
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" Ancestral File or Pedigree
Resource File

" TempleReady for D05
o TempleReady for Windows
i+ BAF far Palm ©%® handhelds

" Other GEDCOM 55

Lhar Set: ILITF-B vl

—ExportTao —Include
" paFsg ¥ hlotes
' PAF 4 r Sources
PAE ™ Multimedia links
~ PAF;J Py r Contact information

¥ confidential data

¥ Mames on living
r Submitter
W LD3 data

¥ Full Information on liwving

— Filter
oAl
% partial Individuals: 1386 Select
Expart.. Cancel Help
Fersonal dwicestral File

- -

&

Once you’ve either chosen All or
Partial (and, if you’ve chosen Partial,
you’ve used the Select function to
identify what data to download), click
Export.

PAF 5 will then warn you (below) that
you’ve selected a character set that
might not include all the characters in
your database. Since you have no
real option, tap Yes.

PAF then begins exporting. When it’s
done, it states how many individuals
and marriages it exported.

The next process can take a minute or
so. Be patient and wait for it to finish.
Don’t click any buttons while waiting!

. E— — . —

The type of export you have selected uses the ARMSEL character set. This may cause some characters to be lost on the
export if you have Unicode thon-Roman) data in your file. Do you want to continue?
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4 Install Tool

Lzer: I EI

File[z] lizted below will be inztalled on your handheld the niest
time yow perform a HotSync operation:

File Mame | File Size | Add..
brighamz. pdb 138K S
Bemaowe...
Dare
— Tip= I
Find ather applizations to inztall on wour handheld at
hittp: f dwanes handzpring. com CIle
The '&dd’ button looks firzt in the YADD-0OM folder
inzide your C:APROGRAR FILESSPaLM folder. This
falder iz a convenient place to store downloaded
handheld files.

Click

PAF automatically places
the exported database in
the Install Tool area on
your PC’s Palm Desktop,
so that the next time you
HotSync your handheld
and your PC, the program
will install the database on
your handheld.

Next, you will HotSync:

Last HotSync operation
349502, 1232 am

) D

Local Svne Moadern Swnc

Enter phone #

.............................. -

Liog
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oo pol_E
@ G

araffiti HotSwvne  Kewboard

Select

@ O @

‘ il Merno Fad My RBoots

FAF Frefs Security

o 0 =€
MOSTER
. A

To Do List  Welcome  =-Master

Note: If you have more than one
database downloaded to your

to a list of your databases. You
can then select one to open.

handheld, PAF for Palm will open

_______________________________________

Next, tap on the PAF icon on your
handheld. If you have only one
database in your handheld, this will
open your database.

PAF automatically gives an exported
PAF for Palm database the same name
as the PAF 5 file from which it is
created. This is problematic if you want
to create multiple handheld databases
from the same PAF 5 file.

To create more than one small database
from your PAF 5 database, you will need
to use the PAF 5 ‘Save As’ feature (from
the File pull-down menu) to make a copy
of your PAF 5 database with a different
name. You can delete this copy of the
file later; for now, give the new copy of
the file a name that will help you identify
the database you are creating from it.

Next, create the new PAF for Palm
database to export to your handheld. At
this point, you can delete the copy of
your PAF 5 database.
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..................... Deleting
a PAF for Palm Database
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Action

Abigail Preferences._..

[-2013 {F)| ratabase Info._.
EORM G| Databases...  AF
Woburn, M| About PAF R

toburn, Middleses, Mazsachusetts

[ Farnily ] [ List ] [Parents ]

To delete a database on PAF for Palm, tap the
Menu icon on your handheld and select Databases
from the Options pull-down menu.

Tap the Delete button at the bottom of the
Databases screen (below, left), then select the
database you want to delete. At the prompt
(below, right), choose Yes if you’ve selected the
correct database to delete.

Marne Feople Kb
fay 406 63
brigharns 1986 225

Setect [RRY oo [Beom] ()

Marne Feople Kb
GV 10c 63
brigharns 1986 225

Delete Database 1]

@ Delete this dotabase 7

I:'T'EE :II: H-:-]
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..................... Comparing PAF §
and PAF for Palm
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PAF 5

Family

Pedigree

Individual
(List)

PAF for Palm is a program that runs an exported PAF database

on a Palm Operating System handheld computer.

Although the names, dates, places, and notes you export
replicate those in a PAF 5 database, the structure of information
on a Palm OS handheld doesn’t exactly replicate the PAF 5
screens, listed here — Family View, Pedigree View, and
Individual (List) View.
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PAF 5

Family

Pedigree

Edit Individual

Individual
(List)

This is how the views of PAF 5 and PAF for Palm compare.
The Family Views are quite similar in content. The Individual or List views

are somewhat similar.

The Pedigree View in PAF 5 has a rough equivalent in the Ancestors and
Descendants screens in PAF for Palm.

The Individual Detail View in PAF for Palm is somewhat comparable to the
Edit Individual screen in PAF 5.

PAF for Palm OS

— o Individual
amily IS Detail
Notes Ancestors Descendants
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el
.................................................. l- List View. ' ...
l. Famlly View
................................................... R Ancestors and- Descend ANES SCIEEINS v rvwvwvnees e
. Indl\ndual Detail View
............................................................................. Notes
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These are the pathways you can follow to move between the various views and
screens in PAF for Palm. Most screens allow you to return to List or Family view.

Family View

List View

|- Tap on name

Tap on date field ..

Individual Detail

Tap on name <

Tap on spouse’s name <

» [ndividual's detail

Notes icon «

P (go to parents’ family)

S (choose spouse, if more

than one spouse)

> Notes

» Spouse’s detail

From pull-down menu:

A

> Ancestors

» Notes
Lifespan
Burial
Christening
LDS ordinances
‘All Info’

v

» Descendants
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.Periunul Ancestral File

List View

Brewer, lonathan 1639-1?53(
Brewer, Martha 1685- I

Click on a Bt , Mary 1679-

name to go to Brewer, Sarah 1677-
that Brigharn, Ann 1606-1675

. g , Erigharn, Antipas -
individual’s Erigharn, Benjarnin Fay  1800- 1384
Family View Brigharm, Constance 1602-1683

Click on
date field
to go to
the
Individual
Detail
View for
that name

. CUrtis w1 TAE-18Y2
. CUFtis 1821-1288

w

[ Search || Mext | 1936 people (i)

Brigharn
Erighann

This is the List View of PAF for Palm.

Click on the NAME to get to the Family View. Click on the DATE FIELD to get to the

Individual Detail View.

Click on the little circled letter i to get an Information screen with brief instructions.

Individuals with no known surname are included at the end of List as:

— Unknown —, <first name>

You can go to names starting with a certain letter by entering that letter in the

Graffiti (or other text entry) area of the handheld.
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Click to see

parents’
Family View Edrnund Brigharn 3 Family View
12 Aug 1733 — 29 Jun 1206
Sarah Ly oo + ¥ Click to
27 Dec 1734 — 27 May 1769 selecta
spouse
m: 2 Mov 1757 F-402 (if >1
spouse)
EHdmL!EdIEEiqhﬁm EEE' T Click to see
, epsibah Brighar - sbouse’s
Click t_o g0 Foger Brigharn 17e2- P ’
to List - | Erigh 176 parents
View armnueEtBrigham - Family
\H[ List | (1) View

Within the Family View, you can navigate to many other screens. Click List to go
back to the List View. Click on the P to see the Family View of the parents of either
spouse. Click on the S to select a different spouse, if an individual had more than
one.

You also can access the Family View for any child listed at the bottom of the
screen by clicking on that child’s name. Clicking on the date field for the child will
take you to the Individual Detail View for the child.
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Click up-

arrows to see
Ancestors

arrows to see
Descendants

Click down-

Edrnund Brigharn
12 Aug 1733 —29 Jlun 1806

Sarah Ly zcom
2¢ Dec 1734 —27 Maw 1769

4
(FI(5)
4

F)

| List |

rm: 2 Mov 1757 F-402
Fdrnund Erigharn i7ea- 7§
Hep:ibah Brigharn 17e0- I
Foger Brigharn 1762- §
carnuel Brigharn 1763- ki

(i)

Y

To see several generations in
the Ancestors screen, click on
one of the up-arrows.

To see several generations in
the Descendancy screen, click
on one of the down-arrows.
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This is the Ancestors Screen. To see further ancestors in

Ancestors this line, click on the name of an ancestor who isn’t the key
individual. Clicking on an ancestor will bring up that
Screen person’s ancestors. The display is limited to three

generations at a time.

The little square dot by the date field indicates that the
individual has offspring listed in this database.

Ancestor: I

Kev individual - - Brigharn, Edrnund m 1733-1806
ey —> Brigham, Lyscam 1769-1345
- - Lyzcorn, Sarah = 1734-1769
Key individual : : )
(3 generation) — Brigham, Curtiz 1793-187
e a1 - = Fay, Benjannin = 1744-1534
ey IndMigUals  —s | Fay. Martha 1775- 1818
- = Stow, Beulah = 1754~
~ to exit (i)
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DE5-|:endunt5
Descendants st _
_ — Brigharn, John 1573-162 1%
Screen generation . | Brigharn, Henry 1599-
2nd = Brigharn, Gillian 1e01-
generation (- Brigham, Thaornas 1603-1653
- - Brigharn, arw = 1643-
- - Brigharn, Thornaz = 1641-1717
3rd - - Brigham, John 164~
generation B L - Brigham, Hannah 16.49-
- - Brighar, Sarmuel 1653-
Also 2nd T Brigharn, Margaret 1605- ]
generation l:i:l
‘ ~ Click
~ to exit

This is the Descendants screen. You can extend it, as with the Ancestry
screen, by clicking on the name of someone with offspring listed in the
database.

Click on a 2" or 3"d generation name with a square dot beside name to
see more generations

Copyright © 2002 Silicon Valley PAF Users Group. All rights reserved. May be copied for incidental instructional or personal use
only. Commercial distribution or display is strictly prohibited.



Individual Detail View

Brigham
Tharnaz

219 (M3 w Lifespan fmm—

Born: 1603

Middiesex, Massachusettsy

[ Family ][ List ] [Forents ] (f)

Lifespan
option
chosen

This is the Individual Detail
View.

You can select how much and
what kind of information to
view by using the little
pull-down menu on the
screen. This is the Lifespan
option.
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Brigharn

Thornas .
219 () w Burial 4— option

10 Dec 1652 (Cambridge.

[ Farnily ][ List ] (Parents ] (§)

Burial

chosen

Woodbury

Michalaz
I-361% (R} w Christen «
9 Apr 1618 (Sauth Petherton,

[ Farnily ][ List ] (Parents ] (§)

Christening
option
chosen

This is another option in
the Individual Detail View.

If an entry has burial
information, you can select
the Burial option from the
pull-down menu.

This also is an option in
the Individual Detail View.

If an entry has christening
information, you can
select the Christening
option from the pull-down
menu.
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Notes

Brigharn
CUrtis

I-55 P} w Motes 4— Notes
option
F

r-l:l-1-i-l-:-l-; i ﬁa i-l:-; . i-.l.l.:; i-.l.-; E. ._i:.l:l :|E i': ;j..:l:.é.l. ..i:.l.:I ............... | c h o s e n

This is another option in the
Individual Detail View.

If an entry has Notes from
PAF 5, you can select the
Notes option from the

passenger iz hi s wife'skinsman & pull-down menu.
, . The entire Note is included,
[ Farily ][ List ] [Farentz ] (§) even long Notes.
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The online instructions for

- From the list arrow, select saving information
the information that you
want displayed.

- . _ Even though you can’t enter

- To Ed_'t aperson = datain information into PAF for Palm, you
the I_“""f_"-' Mermno Fad can export data from to the Memo
application, tap the Menu utility of your handheld, and then
option, and select Export to make notes or changes that you

Nlemo. later upload to your PC. You can

then cut and paste or otherwise

enter the information in to PAF 5.
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Select Export to Memo

Options

fl Export to Memo N
|-30713 (F ) w» - fAll Info -

BORM: & I".'1-:|r 1667

[ Farnily | [ List ] [Farents | (i)

Tap the Menu icon on your
handheld (it usually looks like a
little pull-down menu), and
select Export to Memo. Then, in
the Memo utility, select the
memo you’ve exported and
make whatever notes or
changes you want.

The next time you perform a
HotSync, this new memo will
upload to your PC, and you can
then copy from it or print it.
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..................... How to Find Information
in PAF for Palm
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How to Find Information in PAF for Palm

Abigail Preferences... P
I-2012 {F)| atabase Info_.. 1|

ECRM: G oy rotabases. ~F

[ Farily ] [ List ] [Parents | ()

( Select Preferences

You can use either of two separate
searching utilities to find information in
your PAF for Palm database. One is the
Find function, which allows you to
search for words and numbers anywhere
in your handheld. The other is the
Search feature of PAF for Palm.

The Find feature is the more powerful of
the two. It is represented by a little
magnifying glass icon opposite from
your Menu icon.

To use the Find feature within PAF for
Palm, tap the Menu icon on your
handheld and select Preferences from
the Options pull-down menu.
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Bacon
Abigail
I-2013 {F)
BORM: & Wlar 1667

w - Hll Info -

F'referéﬁcﬁ
' Deszcendants icon
Find options:
0 Marnes
] Flaces

[0 Motes
[0 Dates

[ ok ] [ <ancel ]

Select which featufes to
use with the Find feature
on your handheld

The Preferences box allows you to
customize the Find feature so that you
can search through the PAF for Palm
names, places, notes, and/or dates.

Using Find brings up a screen listing all
the items in your handheld that contain
the names, places, note contents, or
dates (years only) you enter.

This does not work with the program’s
Search button. It works only with the
Find feature, which you access by
clicking on the little magnifying glass
icon.

Also, selecting or deselecting the
Descendants icon checkbox
determines whether little square bullets
mark the names of individuals with
descendants listed in this database.
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The PAF for Palm Search Utility

.Pergnnul Ancestral File Within the PAF for Palm program is a
Search utility. Selecting the Search button
Search at the bottom of some screens brings up
SUFnanme: this Search screen.

You can perform a name search by
entering the surname and either the entire
given name or the first letter of the given
name. The Search program looks for the
entire surname name and matches on
letters within the given name. Capital
letters are not necessary.

We have had mixed success with this
Search utility. Sometimes it worked well;
other times, it did not work at all. Your
success with it may depend on the version
of Palm OS software on your handheld.
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..................... Beaming a PAF for Palm Database
between Handhelds
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Beaming Databases between Handhelds

Marne Feople Kb
rnetcalf 9255 TrE
Rands5 281 30
fay S LLL N %
brigharns 1986 225

Select | Delete | Info |I|

f

Select Beam and then select
the database you want to
send to another handheld

You can use your handheld’s beam
function to transfer entire databases back
and forth between handheld users. This is
much easier than uploading the PAF for
Palm database to a PC, moving it to
another PC, and downloading it to another
handheld.

Click the Menu icon, then select Options
from the pull-down menu. Select
Databases.

Select the Beam button at the bottom of
the Databases screen, then tap on the
name of the database you want to beam to
another handheld.

(Note: One database is highlighted here
because it is running. You can beam any
database, even one that is running.)
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Using Multiple Databases

Choose the Select
button (below), then

database (above)
to open it

tap on the name of a

N

Salact [PEELE

Info | Bearn
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(i)

You can load multiple PAF for
Palm databases into your
handheld, using the PAF 5 Export
feature.

To access databases you have
downloaded, select the Menu icon,
then select Options from the puli-
down menu. Select Databases.

Tap on the Select button at the
bottom of the Databases screen,
then tap on the name of the
database you want to open. If a
database is already open, its name
will appear highlighted (darker,
actually).
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Your Handheld Screen The screen at left will appear on

- your handheld, asking if the
highlighted database is the one
Marne Feople Kb you want to beam to another

retealf 9255 778 handheld.

Rands5% 281 30

Cr A 10¢ 63 After your handheld locates
brigharns 1986 225 another handheld in beaming

BEeam Dotabase 1 range and beams the file to it, the
messages below will appear on
the recipient’s handheld:

@ Bearn this Database?

[ es ][ Mo ] W - Al

@ @ @ The Recipient’s Handheld
FI-:|55 -: Cltme - W < Al
. Beamn i 1
SEIGCt YeS If you @ Do you want to accept @ @ . @
have chosen the 2 adPaln database Address -: City Time
“fﬂy“” "
correct database to into Applications?
beam (Ve ) (M)
Accepting: GedPalmn
w4 database “fay™
If Yes is chosen 2>
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% If your PAF 5 database has thousands of
names, create and export several smaller
databases to export into PAF for Palm —
they will be easier to navigate than one
huge file.

% Be careful what software you download
and install on your PDA. Don'’t overload
it with games and utilities you won’t use.

% |nstall one application at a time and
make sure your handheld still works well
after each new piece of software you
load.
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One Final Tip on HotSync

If you don’t plan to read e-mail on your

handheld, you must configure your handheld
not to download e-mail from your PC.
Otherwise, your handheld could fill up with
e-mail messages that must be deleted one
message a time. Tedious — and annoying!
(We speak from experience...)

To avoid this problem, open the Palm Desktop
screen on your PC. Select the HotSync
pull-down menu, and then select Custom.
Click Change on the the Mail option and then
select Do Nothing. Click OK on that screen,
then click Done on the next screen.
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